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Introduction 
 
EcoDynamo  (Eco logical Dynamics Model) is an application built to enable 
physical and biogeochemical simulation processes of aquatic ecosystems. It's 
an object oriented program application, built in C++ language, with a shell that 
manages the graphical user interface, the communications between classes 
and the output devices where the simulation results are saved. 
 
The simulated processes include: 

- hydrodynamics of aquatic systems: current speeds and directions; 
- thermodynamics: energy balances between water and atmosphere and 

water temperature; 
- biogeochemical: nutrient and biological species dynamics; 
- anthropogenic pressures, such as biomass harvesting. 

 
The ecosystem characteristic properties are described in a model database 
(Configuration Files): morphology, geometric representation of the model, 
dimensions, number of cells, classes, variables, parameter initial values and 
ranges. 
 
The user can choose between file, chart or table to store the simulation 
results. These output formats are compatible with some commercial software 
(like MatLab®) products, enabling their posterior treatment. 
 
Different classes simulate different variables and processes, with proper 
parameter and process equations. Classes can be selected or deselected 
from shell dialogs determining its inclusion or exclusion in each simulation run 
of the model. 
 
This application has an interface module (implementing the EcoDynamo 
Protocol) that enables communications with other programs for external 
control. For example, the simulation runs can be controlled by commands like 
start/stop/pause/restart/step simulation.  
 
Simulation activity can be spied with the help of log files, activated previously 
before the simulation run. 
 
This document describes the operation of the EcoDynamo application and the 
files used for configuration, properties and output results. 
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Main Window 
 
The EcoDynamo's main window is the privileged interface for the user to 
manipulate the models simulation.  
 

 
When a model is opened, its name is added to the name of the application in 
the title area.  
 
The Main Window has five principal areas: Menus, Simulation Panel (also 
called Execute Panel), Output Panel, Communications Area and Status Bar. 
 
The Status Bar area indicates the current task or the last action made by 
EcoDynamo. The other areas are described in detail in the following pages. 
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Model Menu 
 
The Model Menu is used to define new models, open and remove existing 
models, close the working model and set the default model when the 
application starts. 
 
The exit command is also present in this menu. 
 

 
 

New Model... - define a new model with proper Configuration Files. 
 
Open Model... - open a defined model. 
 
Close Model - close the working model. 
 
Remove Model... - remove an existing model. 
 
Defaults Model... - set the default model for the application. 
 
Exit - exits EcoDynamo application. 
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New Model 
 
The New submenu opens a dialog where the user defines a new model for 
simulation.  
 
In this dialog the user must browse for the directory where the model is 
defined (Configuration Files present), supply a name for the model, define if 
the model will be the default model on start-up of the EcoDynamo application 
and if the model is automatically initialised on opening. 
 
When the entire mandatory Configuration Files are present in the directory 
browsed, the dialog looks like (if some configuration file misses background 
will be grey): 

 
The user can select the Classes, Variables and Time specs for the simulation. 
 
After click OK button, one entry is added to the Model Properties File. 



EcoDynamo – Quick Reference  7 

 January 2005 

Open Model 
 
The Open submenu opens a dialog where the user selects one already 
created model for simulation (saved in Model Properties File).  
 
If the model was defined as automatically initialised on opening, it is initialised 
after the click on the OK button. 
 
 

       
 
If one model was in use, the EcoDynamo Properties File is saved in the model 
directory, with the simulation properties (Time specs, Classes and Variables). 
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Close Model 
 
The Close menu closes the working model.  
 
The EcoDynamo Properties File, with the simulation properties, is saved in the 
model directory. 
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Remove Model 
 
The Remove submenu opens a dialog where the user selects one already 
created model for deletion.  
 
The corresponding entry in the Model Properties File is removed. 
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Defaults Model 
 
The Defaults submenu opens a dialog where the user selects the default 
behaviour for each model and the default model on start-up.  
 
The corresponding entries in the Model Properties File are changed. 
 

       
 
For the default model on start-up the background colour of the Location 
textbox is changed to smooth yellow. 
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Exit 
 
This option exits the EcoDynamo application. 
 
If one model is in use, the corresponding EcoDynamo Properties File is 
saved. 
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Specs Menu 
 
The Specs Menu is used to define the simulation options for the model run, 
like time specs, classes selected, variables to output and sub domain of the 
model. 
 
The user can enable/disable the communications to trace the messages 
between EcoDynamo and the other applications (behind the EcoDynamo 
Protocol) on the communications area. 
 

 
 

Morphology... - check morphology values 
 
Time specs... - define time specs for simulation and output register. 
 
Classes... - select Classes for simulation and Variables for output. 
 
Sub Domain... - select domain for simulation. 
 
Enable / Disable Communications Area - enable / disable the 

communications area. 
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Morphology 
 
This dialog shows the model's general morphology - name, grid size, number 
of lines vs. number of columns. 
 

 
 
The information of this panel is filled only after the model initialisation. 
 
The panels "Boundaries" and "TabSheet3" are not used in this version of 
EcoDynamo. 
 
The field "Grid type" is not used in this version of EcoDynamo. 
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Time specs 
 
The Time Specs submenu opens a dialog where the user defines the time 
specifications for simulation and output in different tabs. 
 
The Simulation tab selects the simulation time step and length: 
 

 
 
If the checkbox "EcoWin reference time" is selected the time for each time 
step is based on the EcoWin® reference time. 
 
The "Run mode" option is not yet implemented. 
 
The Output Register tab select the output register frequency and length: 
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The Integration tab is: 
 

      
 
Only "Euler" integration mode is implemented in this version. 
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Classes 
 
The Classes submenu opens a dialog where the user selects the classes for 
simulation and the variables to output results in different tabs. 
 
The Classes definition tab selects the classes for simulation: 
 

 
 

The  button selects classes for simulation (transfers the classes 
marked in the "Available classes" list to the "Selected classes" list). 
 

The  button deselects the classes marked in the "Selected classes" 
list. 
 
In the "Variables output selection" tabbed panel the user selects the variables 
for output register. 
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Variables 
 
From the Classes submenu the user selects the variables for output results. 
 
The tab for variables output selection is: 

 
 

The  button transfers the selected variables in the "Available variables" 
area to all output options. 
 

Each  button copies the variables selected in "Available variables" list 
to the related output area. 
 

Each  button removes the variables selected in the corresponding 
output area. 
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Sub Domain 
 
 
 

The Sub domain submenu opens a dialog where the user selects the points 
for simulation: 

 
The different exclusive options for points selection are: 
 

"All Boxes" - complete domain. 
 
"Read from file..." - read sub domain points from a file. Button click opens 

a dialog enabling the user to browse the file's location. Files must 
have the format described in Points File to be considered. 

 
"Boxes" - select only the boxes listed in the textbox. 
 
"Columns" and "Lines" - the boxes selected are the intersection of the line 

and column numbers listed in the textboxes. 
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Enable / Disable Communications Area 
 
This submenu shows / hides the Communications Area panel. 
 
The selection of this menu when its text is "Enable Communications", displays 
the communications area panel and its text changes to "Disable 
Communications". 
 
The selection of this menu when its text is "Disable Communications", hides 
the communications area panel and its text changes to "Enable 
Communications". 
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Output Menu 
 
The Output Menu is used to select the options for register the model output 
results. 
 
The user can choose different output devices like file, chart and table.  
 
It is also possible to log the messages exchanged between the different 
classes and at different simulation steps. 
 

 
 

Output File... - select output filename and register points. 
 
Output Chart... - select output chart register points. 
 
Output Table... - select output table register points. 
 
Output Logs... - select log simulation steps and file type 
 

The selection of the output options can be done in the Output Panel 
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Output File 
 
The File submenu selects the filename and the boxes for register the 
simulation variables output results in two steps: 
 

Step 1 - Select file name 
 

 
 
The file types can be "xls", "hdf" or "txt". 
 
The "xls" format is obtained with Tab Separated Values and is similar to the 
"txt" format. 
 
The "hdf" format follows the HDF specifications - see NCSA http server 
(http://hdf.ncsa.uiuc.edu/) 
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Step 2 - Select points to register 
 
After entering the filename and click on the "Save" button, one dialog (similar 
to Sub Domain) appears for select the register points: 
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Output Chart 
 
The Chart submenu selects the boxes for register the simulation variables 
output results in chart format. One dialog (similar to Sub Domain) appears for 
select the register points: 
 

          
 
 
To create the output charts, one for each variable, the EcoDynamo launches 
the MatLab® application and benefits from all the features that MatLab® 
supplies to manipulate the chart images. 
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Output Table 
 
The Table submenu selects the boxes for register the simulation variables 
output results in table format. One dialog (similar to Sub Domain) appears for 
select the register points: 
 

          
 
 
The table output format isn't implemented in this version. 
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Output Logs 
 
The Logs submenu presents a dialog to specify the steps where the 
messages exchanged between the different classes are logged: 
 

      
 
 
The log file format can be specified by the user within "xml", "xls" and "txt". 
 
The "xls" format is obtained with Tab Separated Values and is similar to the 
"txt" format. 
 
The "xml" format is more elaborated and is used for more sophisticated pos-
processing methods. 
 
The format of the file behind each type is described in Log Files. 
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Execute Menu 
 
The Execute Menu controls the simulation runs. 
 

 
 

Initialise - initialise model for simulation. 
 
Step - run the simulation step by step. 
 
Run - run the simulation. 
 
Pause - pause the simulation. 
 
Stop - stop / end the simulation. 
 

The control of the simulation runs can be done in the Simulation Panel 
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Help Menu 
 
The Help Menu presents the contents of the manual and the about screen. 
 

 
 

Contents - presents this help manual. 
 
Commands - presents the main window commands 
 
About... - presents the application's authors, version and rights 

information. 
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About 
 
The About Menu presents the application’s authors, version and rights: 
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Simulation Panel 
 
The Simulation Panel presents the simulation state and enables the control of 
the simulation runs. This panel synthesizes the Execute Menu. 
 

                   
 
 
The buttons have the general symbols used in hi-fi control panels: 
 

 Step button - run one step of the simulation. 
 

 Run button - execute the simulation until stopped or paused. 
 

 Pause button - exchange between pause and run mode. 
 

 Stop button - stops the simulation run. 
 

The labels has the following meaning: 
 

"Status" - simulation status (Idle, Running, Paused, Stopped). 
 
"Step" - simulation step number. 
 
"Foreseen Nr of Steps" - expected number of steps for all simulation. 
 
"Elapsed time" - simulation time from the beginning. 
 
"Estimated time left" - presents the expected time for simulation end. 

 



EcoDynamo – Quick Reference  30 

 January 2005 

Output Panel 
 
The Output Panel presents the outputs selected for the simulation run and 
enables the control of the output type. 
 

 
 
 
The checkboxes enable / disable the corresponding output device (File, Chart 
and Table).  
 

Each  button opens the dialog to select the points for the 
corresponding output (see Output File, Output Chart and Output Table). 
 

The  button opens the dialog to select the filename of the output file 
(see Output File). The filename is printed in the combo box area. 
 
The checkbox "Only Mean Values" enables a special kind of output register 
that saves only the mean values (see Mean Values Files). In this case nothing 
is done with the filename. 
 
This panel is an extension of the Output Menu. 
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Communications Area 
 
The Communications Area panel enables the visualisation of the messages 
exchanged between EcoDynamo and other applications.  
 

 
 
In the area "MSGs:" the messages received and transmitted are displayed 
with the prefixes "R: " and "T: ", respectively, followed by the name of the host 
and the message. 
 
The user can format messages and send them to other applications. The 
messages must follow the EcoDynamo Protocol format and are entered in the 
"Send MSG:" area; when the "Enter" key is pressed, the message is sent. 
      
For information on messages format see the EcoDynamo Protocol 
documentation. 
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Configuration Files 
 
The configuration files are the files used to initialise and run the model for 
simulation. Each file has its own significance and utility.  
 
The mandatory files are: 
 

1. Morphology File - describe the morphology of the ecosystem, including 
the number of cells, localisation, geometry and boundary types of each 
one. 

 
2. Classes File - list all classes that can be used by the simulation. 

 
3. Variables File - list the variables treated by each class and their initial 

values. 
 

4. Parameters File - list the parameters used by each class and their 
initial, minimum, maximum and increment values. 

 
The next files are not mandatory but can be useful in some ecosystems or 
simulations: 
 

5. Loads File - requested when the loads process is active. 
 

6. Points File - list sub domain points. 
 
All these files are saved in text format, with Tab Separated Values, and can 
be accessed and modified by any text editor or commercial application (Excel, 
Word, Wordpad, Notepad,...). 
 
The name of the first five files must have a common prefix; the suffix 
distinguishes the file type – see following pages. 
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Morphology File 
 
The morphology filename must terminate with the suffix "Morphology.xls". 
 
It must have the format showed in the next figure: 
 

 
 
The field names NumberOfColumns, NumberOfLines and NumberOfBoxes are 
mandatories and the columns that follow each one of them define the 
dimensions of the model grid: 
 

NumberOfColumns - number of cells in the longitude direction 
NumberOfRows - number of cells in the latitude direction 
NumberOfBoxes - product of the two previous values 

 
After the model initialisation these values are displayed in the dialog of the 
Morphology menu. 
 
There must be a headline with the following mandatory labels: 
 

Columns - number of cell column 
Lines - number of cell line 
BoxDepth - cell depth (meters) 
BoxLength - cell length (meters) 
BoxWidth - cell width (meters) 
BoxElevation - cell elevation of free surface (meters) 
BoxType - cell type (1 - border cell, 0 - inner cell) 
Nboundary - cell North boundary type 
Eboundary - cell East boundary type 
Sboundary - cell South boundary type 
Wboundary - cell West boundary type 

 
Boundary types are coded like: 
 

0 - no frontier 
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1 - river boundary 
2 - sea boundary 
4 - solid boundary (earth) 

 
The column with the label ModelType indicates the model type (p.e. 2DH 
means two-dimensional horizontal). In this version of EcoDynamo this field is 
not used. 
 
The following lines are filled with the values for the corresponding fields. 
 
NOTE: The grid is viewed as a rectangle: 

line number  increases from North to South (top-down) 
column number  increases from West to East (left-right). 
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Classes File 
 
The classes filename must terminate with the suffix "Classes.xls".  
 
It must have the format showed in the next figure: 
 

              
 
The labels Number of Classes , Class name  and Status  are mandatory. 
 
The column that follows the label Number of Classes  must define the number 
of classes that will be used by the model. 
 
The line with labels Class name  and Status  head those with the classes 
names and their initial state of activation. There must be an agree between 
the number of classes defined and the number of lines with class names. 
 
The names of the classes are the names of the class objects defined by each 
DLL, included with the EcoDynamo code, which implements the simulation of 
the different processes.  
 
In this version of EcoDynamo the field Status  is not taken into account 
because the class activation is done in the Classes menu and activation 
changes are saved when the model is closed in the EcoDynamo Properties 
File. 
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Variables File 
 
The variables filename must terminate with the suffix "Variables.xls".  
 
This file lists all the classes' variables, with their initial values, and each class 
imposes its own format for the variables filling. 
 
For further information read the EcoDynamo manual. 
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Parameters File 
 
The parameters filename must terminate with the suffix "Parameters.xls". 
 
This file lists all the classes' parameters and their initial, minimum, maximum 
and increment values, and each class imposes its own format for the 
parameters filling. 
 
For further information read the EcoDynamo manual. 
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Loads File 
 
The loads filename must terminate with the suffix "Loads.xls".  
 
It must have the format showed in the next figure: 
 

 
 
The field names NumberOfLoads , NumberOfDaysForLoads , LoadLines , 
LoadColumns  and LoadName  are mandatories: 
 

NumberOfLoads  - The line behind contains the number of load discharges 
points.  

NumberOfDaysForLoads  - The line behind contains the number of days 
with load discharges. 

LoadLines  - The lines behind contain the line numbers of each load 
discharge point. The number of lines filled must agree with the 
number of loads defined. 

LoadColumns  - The lines behind contain the column numbers of each 
load discharge point. The pair Line x Column defines the cell point. 
The number of lines filled must agree with the number of loads 
defined. 

LoadName  - The lines behind contain the names of the load discharges 
entities. The number of lines filled must agree with the number of 
loads defined. 

 
For each discharge point, one column labelled FlowN  must be added to the 
file (N is the flow number) with NumberOfDaysForLoads  lines, one load value 
for each day. 
 
 
NOTE: The grid is viewed as a rectangle: 

line number  increases from North to South (top-down)  
column number  increases from West to East (left-right). 
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Points File 
 
The points file should have a format like the one showed in the next figure: 
 

                         
 
The field names COLUNA_X_  and LINHA_Y_  are mandatory: 
 

COLUNA_X_  - The lines behind contain the column numbers of each 
point. The pair Line x Column defines the cell point. 

LINHA_Y_  - The lines behind contain the line numbers of each point. The 
pair Line x Column defines the cell point. 

 
In the example shown above the values of columns COLUNA_X_ and 
LINHA_Y_ were built from X and Y (extracted with the help of one GIS 
application). 
 
NOTE: The grid is viewed as a rectangle: 

line number  increases from North to South (top-down)  
column number  increases from West to East (left-right). 



EcoDynamo – Quick Reference  40 

 January 2005 

Output Files 
 
The output files are the files generated by the EcoDynamo application during 
the simulation. 
 
The results can be saved in one General Output File or several Mean Values 
Files.  
 
The Log Files save the communications between classes during the 
simulation in some specified steps. 
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General Output File 
 
The General Output File have, by default, 3 formats: "xls", "hdf" or "txt". 
 
The "xls" and "txt" formats are text files saved with tabs separating values. 
The "xls" format is used for Excel application quick view with Tab Separated 
Values. The format is: 
 

           
 
The header row contains the fields significance. The first five columns are 
fixed for all registers: time (in hours), register step, column, line and cell 
numbers. 
 
After the fifth column appear the variables in the order selected in Variables 
Dialog to file output. 
 
Only the cells selected in the Points File are registered. 
 
The "hdf" format follows the HDF specifications - see NCSA http server 
(http://hdf.ncsa.uiuc.edu/). When this option is chosen all the points of the 
model domain are saved. 
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Mean Values Files 
 
The option to generate only Mean Values Files enables the user to run the 
model with a minor time step (normally only the hydrodynamic part of the 
model) and save the mean values of flows and velocities in files. To do that 
the classes file must include classes with this feature implemented. 
 
The user will use this files to run the model later with a time step greater than 
the used in the previous simulation. 
 
The Mean Values Files are formatted as "xls" files and their names follow a 
special order. Each file saves 10 register steps. 
 
The first file to be saved has the name "HydroTimeSeriesValues_0.xls", the 
second "HydroTimeSeriesValues_1.xls", and so on. 
 

 
 
The header row contains the fields significance. The first three columns are 
fixed for all registers: time (in seconds from January 1, 1970 00:00), register 
step and cell number. 
 
After the third column appear the mean variables in the order selected in 
Variables Dialog to file output. 
 
Only the cells selected in the Points File are registered. 
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Log Files 
 
The log files save the communications between classes during the simulation 
in some specified steps (specified in Output Logs). Each step is saved in one 
separated file named "LogfileN", where N is the step number. The extension 
name reflects the format used. 
 
The "xls" format is obtained with Tab Separated Values and is similar to the 
"txt" format. The header row describes each column field: 
 

STEP - time step 
Class_Name  - origin class of the communication 
Type  - method invoked: “Update” or “Inquiry” 
Data_Class  - destination class of the communication 
Variable - variable of destination class 
Value - value of the variable 
Box_Number - number of cell 

 
The Type "Update" means that class Class_Name will update the variable 
Variable  in the class Data_Class with the value Value in the cell Box_Number . 
 
The Type "Inquiry" means that class Class_Name asks for the value of the 
variable Variable  in the class Data_Class  in the cell Box_Number . The value is 
returned in Value . 
 

 
 
The "xml" format is more elaborated and is used for more sophisticated pos-
processing methods: 
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The root of the XML file is the LOG element.  
 
This element is composed by one STEP element, with the time step number, 
and multiple REGISTRY elements, each one with 6 elements containing the 
information described previously (one registry for each line). 
 



EcoDynamo – Quick Reference  45 

 January 2005 

Properties Files 
 
There are two kinds of properties files: 
 

1. Model Properties File saves the models already created by the 
EcoDynamo application. 
 

2. EcoDynamo Properties File saves, in the model directory, the 
simulation properties defined in the last usage by EcoDynamo 
application. 
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Model Properties File 
 
The file "Models.properties" belongs to the EcoDynamo application's directory. 
 
It saves the models used by EcoDynamo application and is created when the 
application ends.  
 
Here is an example of model properties file: 
 

            
 
The first line contains the number of models already created and opened by 
EcoDynamo (property name is DefinedModels ). 
 
For each model created 4 properties are included: 
 

Model - name of the model 
Path - location of the model directory 
Default – “true” if the model is the default model, “false” otherwise 
AutoInit – “true” if the model is initialised when opened, “false” otherwise. 

 
Each model property has the suffix _N where N is the order number of the 
model in the file. 
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EcoDynamo Properties File 
 
Each model created by EcoDynamo application will have a file named 
"EcoDynamo.properties" in its directory. 
 
The file is created when the model is closed, and saves the properties of the 
simulation.  
 
Here is an example of one EcoDynamo properties file: 
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The properties saved in the file are: 
 

PrefixName - prefix that heads each mandatory file 
Type - not used in this version of EcoDynamo 
PathName - location of the model directory 
NrClassesAvailable - number of classes available in classes file 
Available_N - list of available classes [N is the class order number] 
NrClassesSelected - number of classes selected [Classes dialog] 
Selected_N - list of selected classes [N is the class order number] 
NrVariablesAvailable - number of variables available from classes 

selected 
AvailableVars_N - list of available variables [N is the variable order 

number] 
NrVariablesSelectedFileOutput - number of variables selected for file 

output [Variables dialog] 
SelectedVarsFileOutput_N - list of selected variables to file output [N is the 

variable order number] 
NrVariablesSelectedGraphOutput - number of variables selected for graph 

output [Variables dialog] 
SelectedVarsGraphOutput_N - list of selected variables to graph output [N 

is the variable order number] 
NrVariablesSelectedTableOutput - number of variables selected for table 

output [Variables dialog] 
SelectedVarsTableOutput_N - list of selected variables to table output [N is 

the variable order number] 
StartTime - simulation start time (seconds from January 1, 1970 00:00) 

[Time specs dialog (Simulation tab)] 
FinishTime - simulation finish time (seconds from January 1, 1970 00:00) 

[Time specs dialog (Simulation tab)] 
TimeStep - simulation time step (in seconds) [Time specs dialog 

(Simulation tab)] 
TimeUnit - simulation time step unit [Time specs dialog (Simulation tab)] 
RunMode - simulation run mode [Time specs dialog (Simulation tab)] 
Integration - simulation time integration [Time specs dialog (Integration 

tab)] 
OutputStartTime - output register start time (seconds from January 1, 

1970 00:00) [Time specs dialog (Output Register tab)] 
OutputFinishTime - output register finish time (seconds from January 1, 

1970 00:00) [Time specs dialog Output Register tab)] 
OutputFrequency - output frequency time (in seconds) [Time specs dialog 

(Output Register tab)] 
OutputTimeUnit  - output frequency time unit [Time specs dialog (Output 

Register tab)] 


